Introduction
ANT is the front-end application that allows a trader to perform several trading functions that include:
· Real-time market data of individual contracts and market indices.
· Support for multiple exchanges (MCX) and segments (Commodity).
· Various types of orders - Normal Buy/Sell, Cover Order.
· View Order History, Trades and Positions report.
· View overall P&L in carry-forward positions synchronized with back-office BOT.
· View Stock Holdings and Accounts.
· Trade from charts with Normal Order and Cover Order.
· Quick limit orders through chart.
· 80+ Technical Indicators for Technical Analysis.
· 10 types of charts such as Candle, Bar, Heikin-Ashi, etc.
· Several drawing tools for analysis.
· Free historical data for Back-testing.
· Scripted Alerts and Scanner.
· Access to public Expert Advisors.
These features are explained comprehensively in consecutive sections. The document is classified into the various menus available in ANT.
ANT allows the end user to trade through a single account id. Few key features that can be useful to any user are given in this document.
[bookmark: __RefHeading___Toc444183479]Login
ANT is initiated by first logging in to it.


[bookmark: __RefHeading___Toc444183480]Login with Two Factor Authentication
Two Factor Authentication login process is used to verify the authentication of the valid user while logging in. Two Factor Authentication process is implemented through 2FA Question and Answer.
Steps to Implement Two Factor Authentications: (Question and Answer)
Step 1: After installing ANT on system, an icon named ANT will be placed on the desktop. One has to just double-click on the icon to start the application. After the application starts, a login window will show up asking for Client Id and Password. When users open his/her trading account with Alice Blue, user gets a Client Id and two passwords (one each for login and transaction). Enter the Client-Id and on successful authentication of client id the user will be able to enter the password. After entering login password, hit Login.

Following is a detailed description of the functions given in the Login window:
Client Id: The user name or login id of the user is to be entered.
Password: The corresponding password for the user name must be entered.
Forgot Password: This can be used when user forgets his/her password.
Change Password: This option can be used to change the existing password to new one.
Login: The user has to simply click on the ‘Login’ button or press ‘Enter’ on his keyboard, after entering relevant log in details on his terminal.
Step 2: After entering the password user has to click on Login, user will be directed to the 2FA security questions window. System will provide the random questions to user which user has answered when he/she is logging in for the first time. User has to answer 2 questions correctly to login successfully into ANT.
Answer the question appeared in 2FA security question window and press OK to login.



[bookmark: __RefHeading___Toc444183481]Forgot Password
If a user click on forgot password, the below showed window opens and one can give his/her client ID, E-mail, PAN details and can generate new password to his registered E-mail ID.



[bookmark: __RefHeading___Toc444183482]Market Watch Features
All features related to market menu are described below
[image: ]
Market Watch is one of the most commonly accessed features in any trading application. The user can do following things using a market watch.
· Set up a portfolio of scrips of their choice in the order he/she wants to appear.
· One can view any relevant information pertaining to any scrip/contract by setting up the columns in the desired sequence. This can be done from the list of available columns.
· The trader can select columns based on his choice.
· The user can call other functions like the Order entry window, SnapQuote (market depth window), Pending order window, Net position window and Tradebook for the scrip when one has selected from the market watch. This is done by pressing the key strokes assigned to that particular function.
· To organize the scrips, drag and drop any rows. The user can sort the scrips in ascending or descending order by a click on the top of the column, which the user wants to treat as the parameter to sort the market watch.
· User can call few important features from the market watch by just a right click. Few features that can be called from market watch include various order placing windows, Order book, Trade book, scrip properties, SnapQuote, positions and holdings.
· To remove any scrip, right click and select ‘Delete’ or hit Delete Button.


[bookmark: __RefHeading___Toc444183483]Market Watch Toolbar
The Market Watch toolbar appears at the top. To add scrip, select a specific instrument through the given filters and click on ‘Add’ button.
· User can open Intra-day chart for any scrip by double clicking on the chart column.
· While logging out of the application, ANT will ask user to save market watch, user can click on save or user can change the settings by un-checking the saving market watch on exit in Market Watch tab in User Settings, it’ll automatically save the market watch while exiting ANT and the same market watch will be opened for him/her for next login time.
You can use MarketWatch toolbar to open Order book, Trade book, Admin position, Cash Position, Stock Holdings, Chart drawings. You can open a chart, save your workspace or load previously saved workspace. You can also open Alerts window.



[bookmark: __RefHeading___Toc444183484]Script Details
Shortcut: Shift + F7

The user can call this window by pressing shift+F7 for any of the scrip added in market watch after selecting it. It provides the basic information about the selected scrip. The information also includes board lot quantity, freeze quantity, tick size, Price unit, Exchange, Series, etc.


[bookmark: __RefHeading___Toc444183485]Products Tag (Product Type)
ANT got some pre-defined product tags which include Normal (NRML), Cash and Carry (CNC), Margin Intraday Square-Off (MIS).
· NRML: For trading FNO for overnight position.
· CNC: For trading Equity in delivery.
· MIS: For trading Equity & FNO in intraday.
At the time of order placement the user can select the appropriate product under which the order has to be placed. This feature is not only useful from RMS and Compliance point of view but also from MIS reporting point, it is of great significance.


[bookmark: __RefHeading___Toc444183486]SnapQuote(Market Depth)

The user can call the SnapQuote window for the selected scrip by pressing F6, by double clicking on the selected scrip or from the Quick order window in charts. The window gives the complete shot of the way the scrip is performing in the market on the day as well as at that particular point of time. The information like open, high, low, previous day close gives an indication how the scrip fared on that particular day and the top five bid/ask gives the indication about what kind of liquidity that scrip has in the market and at what price levels. This information will give better ANTcture about the scrip to the user before taking position in that particular scrip.
User can also Compact SnapQuote, for this, select Compact SnapQuote from user settings.

After selecting Compact SnapQuote from user settings, SnapQuote will look like this:



[bookmark: __RefHeading___Toc444183487]Charts
Shortcut: Shift + C
To load a chart, click the chart button on the MarketWatch toolbar or can use shortcut keys or by right clicking on a selected scrip and click on Chart.
Note: Intraday Charts can also be open by double clicking on charts columns for particular scrip.
 Change the icons
A chart settings screen will display. Here you specify the Symbol, Chart Periodicity, Bar Interval, and Bar History. Click the OK button to load the chart. By Default the selected Symbol in MarketWatch tab is populated. Always use upto 60 days for the optimum performance.

By default a two-dimensional candle chart will display. You may change the candle style to Three-dimensional candles, open-high-low bars, or a number of other price styles listed in the Price Style drop down menu.

Technical indicators may be added to the chart via the Technical Analysis menu. Simply select a technical indicator then click on the chart. Note that if user opened multiple charts at the same time, he/she must click on a chart to select it prior to selecting a technical indicator.
If multiple charts are shown on the same screen, a selection border will be drawn around the selected chart. It can see in the image below, a blue selection border has been drawn around the lower chart area, which is currently selected. Selection border drawn around the selected chart can be decided according to the ANT themes. For Alice Blue theme, selection border color is white.

Once a technical indicator has been added to the chart, user may edit the indicator’s properties by first left clicking on the indicator or by double clicking on the indicator, then right clicking and selecting “Edit Series”. The indicator property dialog will display, where user can change indicator parameters and colors.

User can drag and drop series from one area of the chart to another. To do so, simply click the series and then drag it into another area (such as on top of the price bars).

user can also resize chart panels. Simply click near the borders and drag the panel either up or down.
To navigate the chart, click the zoom in, zoom out, scroll left and scroll right buttons located on the chart toolbar. Note that a chart can only be scrolled after user zoomed in to a certain degree.

ANT also allows you to apply templates to charts so that your favorite indicators and colors can be applied at once. Simply click the “Apply Template” button on the toolbar or select the Chart, Apply Chart Template menu. Note that the chart must have a volume series in order for this feature to work.
Delete All Drawings button can remove all the drawing objects in one click from the selected chart.
Trend lines, Gann fans, Error channels and other line studies can be added via the “Chart Tools” menu in the main menu. It could also be selected from Insert drawing Tools from Right click menu in the chart.

Main Menu

Right Click Menu in chart
User can also add buy, sell, exit symbols, text objects, and other objects via the “Chart Tools” menu. These objects may be placed anywhere on the chart and may be repositioned or removed by a left click.


[bookmark: __RefHeading___Toc444183488]Important Features in Charts
· Day Separator: User can use this feature on charts by selecting Day Separator in right click menu in charts. This feature will separate all the candles day wise from starting of the trading day to the end of the day. This feature is available for Candle and Bar charts only.
· [bookmark: _GoBack]ANTvot Points: User can use this feature on charts by selecting ANTvot Points in right click menu in charts. This feature is not available for BSE exchange. ANTvot Point is a price level that is used by traders as a possible indicator of market movement. A ANTvot Point is calculated as an average of significant prices (high, low and close) from the performance of a market in the prior trading period.
· Data Box: User can use this feature on charts by selecting Data Box in right click menu in charts. This box will show OHLCV values by moving the mouse over all the candles and values of Indicators added on charts. Data Box makes it easy for user to see the OHLCV and indicators values.
· Cross Hair: User can use this feature on charts by selecting Cross Hair in right click menu in charts. While the crosshair mode is in use, traders can move the crosshair over any price bar, or any part of a price bar, and the corresponding time and price values will be readily identifiable. Crosshair mode makes it easy to find a price bar's high or low, and the time and day that the bar printed.
· Home key: User can use Home key from keyboard to see first 100 candles of the chart opened.
· End Key: User can use End key from keyboard to see last 100 candles of the chart opened.


[bookmark: __RefHeading___Toc444183489]Saving and Loading Charts
Loading of chart could be accessed from the file menu in Main menu. The Charts loaded from disk will be Live.
Note: If internet connection is not stable or disconnecting frequently, candles in saved chart will be missing or there will be some missing data in Charts loaded from disk.
Charts can be saved and loaded back into ANT using Load Chart from Disk menu in File Menu. Save Chart saves the file on the Disk.
Save Chart as image saves the charts as snapshot. Also Chart Template could be saved for later applying on charts to do similar technical study on all the charts.



[bookmark: __RefHeading___Toc444183490]Chart Trading
Orders through charts can be put in two ways
· Quick Limit Order Window
· Trade by right click menu in Charts.
[bookmark: __RefHeading___Toc444183491]Trading through Quick Order
Shortcut: Ctrl + Q
Limit Orders could be placed through Quick Order sticker placed in top left corner of the chart. Buy and sell button are shown by Green and Red Color respectively showing the best available for selling and buying. It’s a movable sticker and could be placed according to convenience. Also it could be disabled if the user does not want to see it, by pressing Ctrl + Q or by un-checking View Quick Order in View menu.
[image: http://tradelab.in/wp-content/uploads/2016/03/quick-limit-order.png]
A confirmation message for submit order comes showing the details of the order. Once Submit button is clicked or Enter key is pressed the order is send.
[bookmark: __RefHeading___Toc444183492]Trading through Right Click Menu
You can trade from any chart by right clicking and selecting “Buy Here” or “Sell Here”.

Please note that only Limit and Stop Loss Market Order type is supported.
When you place a Buy order on a chart if price related to cursor position is above the Close price of last candle then it would select SL-M order type and if it is below it will put a Limit order type.
Similarly, if you Place a Sell Order on the chart, if price related to cursor position is above the Close price of last candle then the order type selected would be Limit and if price is below Close price of last candle the order type selected would be SL-M.
Your order details can be viewed in Order Book (Press F3)
WARNING! When using this feature be SURE to create your trigger line ABOVE or BELOW the candle and not INSIDE the candle. By placing your trigger line INSIDE a candle, your order will be triggered even though the candle may not have penetrated from the reverse side.
Do not attempt to use this feature with price styles other than candlestick or OHLC bars.


[bookmark: __RefHeading___Toc444183493]Chart Types
The various types of Charts available in ANT are:
Bar Chart
This chart type is the most common way to display data for analysis. Open, high, low, and close prices are shown for the time increment represented by the bar.
[image: ]
Candle Chart
This chart type uses the same price data as regular bar charts, with each candlestick representing the open, high, low, and close. The thick part, called the real body, represents the range between opening and closing prices. Long thin lines, shadows and wicks/tails, represent the range of price movement for the bar.
[image: ]
Candle Volume
As its name implies, Candle Volume charts merge volume into candlesticks. This allows chartists to analyze both price action and volume with one look at the price chart. It shows candle ticks are used to see the open and close for each period, as well as the high and the low.
[image: ]
Equi Volume
Equi Volume is a price plot that incorporates volume into each period. Equi Volume charts looks similar to candlestick charts, but the candle ticks are replaced with Equi Volume boxes that can be square or rectangle.
[image: ]
Equi Volume Shadow
Equi volume Shadow measures the relationship between price, volume and the shadow. Price is measured on the vertical axis and volume is measured on the horizontal axis. Equi volume combines price and volume in a two-dimensional box. The top line of the box is the high for the period and the bottom line is the low for the period. The width of the box represents the volume for the period. The shadow (empty region in the box) is based on the difference between open and either high or low depending on whether the price closed lower than the open of higher than the open for that interval bar.
[image: ]

Heikin Ashi
Heiken-Ashi means “average bar” in Japanese. Open, High, Low and Close prices of HA candle ticks are not actual prices, they are results from averaging values of the previous bar, which helps eliminate random volatility.
[image: ]
Kagi
This chart type looks like a continuous line that changes directions and switches from thin to bold. The direction changes when the price changes beyond a predefined amount, and the line switches between thin and bold if the last change bypassed the last horizontal line.
[image: http://tradelab.in/wp-content/uploads/2016/03/kagi.png]
Point & Figure
This chart type only plots price movements, without taking time into consideration. A column of X’s is plotted as the price rises—and O’s as the price drops.
[image: http://tradelab.in/wp-content/uploads/2016/03/pfnew.png]
Renko
This chart type only plots price movements, without taking time or volume into consideration. It is constructed from ticks and looks like bricks stacked in adjacent columns. A new brick is drawn after the price passes the top or bottom of previously predefined amount.
[image: http://tradelab.in/wp-content/uploads/2016/03/Renko.png]
Three Line Break
This chart type only plots price movements, without taking time or volume into consideration. This chart type displays a series of vertical boxes that are based on price changes.
[image: http://tradelab.in/wp-content/uploads/2016/03/3LB.png]


[bookmark: __RefHeading___Toc444183494]Technical Indicators
There are 80 popular technical indicators provided with ANT. These technical indicators help user to analyze the charts.


[bookmark: __RefHeading___Toc444183495]Adding Technical indicator
The available technical indicators in ANT are as follows:
Simple Moving Average
The Simple Moving Average is simply an average of values over a specified period of time. A Moving Average is most often used to average values for a smoother representation of the underlying price or indicator.
Exponential Moving Average
An Exponential Moving Average is similar to a Simple Moving Average. An EMA is calculated by applying a small percentage of the current value to the previous value. An EMA applies more weight to recent values.
Time Series Moving Average
A Time Series Moving Average is similar to a Simple Moving Average, except that values are derived from linear regression forecast values instead of raw values.
Triangular Moving Average
The Triangular Moving Average is similar to a Simple Moving Average, except that more weight is given to the price in the middle of the moving average periods.
Variable Moving Average
A Variable Moving Average is an exponential moving average that adjusts to volatility.
VIDYA Moving Average
VIDYA (Volatility Index Dynamic Average), developed by Chande, is a moving average derived from linear regression R2. As VIDYA is a derivative of linear regression, it quickly adapts to volatility.
Welles Wilder Smoothing
Wilder’s Smoothing indicator was developed by Welles Wilder and mentioned in his book” New Concepts in Technical Trading”. Wilder used the Smoothing indicator as a component in several of his other indicators including the RSI. Wilder’s Smoothing indicator can be used in the same capacity as other moving averages. The smoothing indicator is used as an input in Wilder’s other indicators such as the RSI, Wilder’s Swing Indicator and Wilder’s Volatility Indicator.
Weighted Moving Average
A Weighted Moving Average places more weight on recent values and less weight on older values.
Williams %R
Williams’ %R measures overbought/oversold levels. The most widely used method for interpreting Williams’ %R is to buy when the indicator rises above 80 or sell when the indicator falls below 20.
Williams Accumulation Distribution
The Accumulation/Distribution indicator shows a relationship of price and volume. When the indicator is rising, the security is said to be accumulating. Conversely, when the indicator is falling, the security is said to being distributing. Prices may reverse when the indicator converges with price.
Volume Oscillator
The Volume Oscillator shows a spread of two different moving averages of Volume over a specified period of time. The Volume Oscillator offers a clear view of whether or not Volume is increasing or decreasing.
Vertical Horizontal Filter
The Vertical Horizontal Filter (VHF) identifies whether a market is in a trending or choppy movement phase. The VHF indicator is most commonly used as an indicator of market volatility. It is also frequently used as a component for other technical indicators.
Ultimate Oscillator
The Ultimate Oscillator compares prices with three oscillators, using three different periods for calculations. The most popular interpretation of the Ultimate Oscillator is price/indicator divergence.
True Range
The Average True Range (Wilder) measures market volatility. High ATR values may signal market bottoms, and low ATR values may signal neutral markets.
TRIX
TRIX is a momentum oscillator that shows the rate of change of an exponentially averaged closing price. The most common interpretation of the TRIX oscillator is to buy when the oscillator rises and sell when the oscillator falls. 3, 8 and 14 period moving averages are often used to smooth the TRIX oscillator.
Rainbow Oscillator
The Rainbow Charts indicator is a trend-following indicator. It is based on a two-period simple moving average. Over that, recursive smoothing is applied to the original MA (moving average) to create nine additional moving averages, each being based on the previous MA. Through a process of repetitive smoothing, the result obtained is a full spectrum of trends, which plotted on a chart with continuous colors, have the appearance of a rainbow. The Rainbow Oscillator Indicator is, like the Rainbow Charts, an indicator used to follow trends and its graph is plotted based on the same calculations made to find the Rainbow Charts. The oscillator is a derivative from a consensus of the Rainbow Charts trends, defining the highest high value and lowest low value among those moving averages, and creates an oscillator and bandwidth lines according to those calculations.
Price Oscillator
The Price Oscillator shows a spread of two moving averages. The Price Oscillator is basically a moving average spread. Buying usually occurs when the oscillator rises, and conversely, selling usually occurs when the oscillator falls
Parabolic SAR
Parabolic SAR (SAR) is a time and price technical analysis tool primarily used to identify points of potential stops and reverses. In fact, the SAR in Parabolic SAR stands for "Stop and Reverse". The indicator's calculations create a parabola which is located below price during a Bullish trend and above Price during a Bearish Trend.
Momentum Oscillator
The momentum indicator calculates change of over a specified length of time as a ratio. Increasingly high values of the momentum oscillator may indicate that prices are trending strongly upwards. The momentum oscillator is closely related to MACD and Price Rate of Change (ROC).
MACD
The MACD is a moving average oscillator that shows potential overbought/oversold phases of market fluctuation. The MACD is a calculation of two moving averages of the underlying price/indicator. Buy/Sell interpretations may be derived from crossovers (calculated from the SignalPeriods argument), overbought/oversold levels of the MACD and divergences between MACD and actual price.
Ease of Movement
The Ease of Movement oscillator shows a unique relationship between price change and volume. The Ease of Movement oscillator rises when prices are trending upwards under low volume, and likewise, the Ease of Movement oscillator falls when prices are trending downwards under low volume.
Directional Movement System
Directional Movement System (DMS) is composed of 3 indicators:
Negative directional indicator (DI-): Negative directional indicator (DI-) is component of average directional index (ADX). If DI- is sloANTng forward, it is signal that downtrend is increasing.
Positive directional indicator (DI+): Positive directional indicator (DI+) is component of average directional index (ADX). If DI+ is sloANTng upward, it is signal that uptrend is increasing.
Average directional index (ADX): Average Directional Index (ADX) was created by J. Welles Wilder as indicator of trend strength.
Detrended Price Oscillator
The Detrend Price Oscillator is used when long-term trends or outliers must be removed from prices or index indicators. This indicator is often used to supplement a standard price chart. Other indicators can be plotted over the Detrended Price Oscillator.
Chande Momentum Oscillator
The Chande Momentum Oscillator (Chande) is an advanced momentum oscillator derived from linear regression. Increasingly high values of CMO may indicate that prices are trending strongly upwards. Conversely, increasingly low values of CMO may indicate that prices are trending strongly downwards. CMO is related to MACD and Price Rate of Change (ROC).
Chaikin Volatility
The Chaikin Volatility Oscillator is a moving average derivative of the Accumulation/Distribution index. The Chaikin Volatility Oscillator adjusts with respect to volatility, independent of long-term price action.
Aroon
The Aroon indicator is used to define if a currency-trading price is following a trend or sideways and to measure the trend's strength. If the currency's trading price is going up, the end for this period will be closer, and on the contrary. The Aroon indicator shows in percents how much time passed between the up (highest) and down (lowest) close starting from the beginning of a period.
Aroon Oscillator
The Aroon Oscillator, the positive value shows a coming or an upward trend, and the negative value indicates a downward trend. When the absolute value of an oscillator becomes higher, an indication of a trend is also getting stronger.
Linear Regression
Linear Regression R-Squared
Linear Regression Forecast
Linear Regression Slope
Linear Regression Intercept
Linear regression is a common statistical method used to forecast values using least squares fit. The result for Linear Regression has four Field objects: “R-Squared”, “Forecast”, “Slope” and “Intercept”. Where R-Squared is the coefficient of determination, Forecast is the linear regression forecasted value for the next period, Slope is the slope value for the periods being analyzed and Intercept is the end period’s Y intercept value.
Price Volume Trend
The Price and Volume Trend index is closely related to the On Balance Volume index. The Price and Volume Trend index generally precedes actual price movements. The premise is that well-informed investors are buying when the index rises and uninformed investors are buying when the index falls.
Performance Index
The Performance indicator calculates price performance as a normalized value or percentage. A Performance indicator shows the price of a security as a normalized value. If the Performance indicator shows 50, then the price of the underlying security has increased 50% since the start of the Performance indicator calculations. Conversely, if the indictor shows –50, then the price of the underlying security has decreased 50% since the start of the Performance indicator calculations.
Commodity Channel Index
Commodity Channel Index (CCI) is a versatile indicator that can be used to identify a new trend or warn of extreme conditions. Lambert originally developed CCI to identify cyclical turns in commodities, but the indicator can successfully applied to indices, ETFs, stocks and other securities. In general, CCI measures the current price level relative to an average price level over a given period of time. CCI is relatively high when prices are far above their average. CCI is relatively low when prices are far below their average. In this manner, CCI can be used to identify overbought and oversold levels.
Chaikin Money Flow
Developed by Marc Chaikin, Chaikin Money Flow measures the amount of Money Flow Volume over a specific period. Money Flow Volume forms the basis for the Accumulation Distribution Line. Instead of a cumulative total of Money Flow Volume, Chaikin Money Flow simply sums Money Flow Volume for a specific look-back period, tyANTcally 20 or 21 days. The resulting indicator fluctuates above/below the zero line just like an oscillator. Chartists weigh the balance of buying or selling pressure with the absolute level of Chaikin Money Flow. Chartists can also look for crosses above or below the zero line to identify changes on money flow.
Weighted Close
The Weighted Close indicator is simply an average of each day's price. It gets its name from the fact that extra weight is given to the closing price. The Median Price and TyANTcal Price are similar indicators.
Volume ROC
The Volume Rate of Change indicator shows clearly whether or not volume is trending in one direction or another. Sharp Volume ROC increases may signal price breakouts.
TyANTcal Price
A TyANTcal Price is simply an average of one period’s high, low and close values. A TyANTcal Price is often used as an alternative way of viewing price action, and also as a component for calculating other indicators.
Standard Deviation
Standard Deviation is a common statistical calculation that measures volatility. Other technical indicators are often calculated using Standard Deviation. Major highs and lows often accompany extreme volatility. High values of Standard Deviation indicate that the price or indicator is more volatile than usual.
Price ROC
The Price ROC shows the difference between the current price and the price one or more periods in the past. A 12-day Price ROC is most often used as an overbought/oversold indicator.
Median Price
A Median Price is simply an average of one period’s high and low values. A Median Price is often used as an alternative way of viewing price action, and also as a component for calculating other indicators.
High Minus low
Returns high price minus low price.
Bollinger Bands
Bollinger Bands are similar in comparison to moving average envelopes. Bollinger Bands are calculated using standard deviations instead of shifting bands by a fixed percentage. Bollinger Bands (as with most bands) can be imposed over an actual price or another indicator. When prices rise above the upper band or fall below the lower band, a change in direction may occur when the price penetrates the band after a small reversal from the opposite direction.
Fractal Chaos Band
Fractal Chaos Bands Indicator helps us to identify whether the stock market is trending or not. When a market is trending, the bands will have a slope and if market is not trending the bands will flatten out. As the slope of the bands decreases, it signifies that the market is choppy, insecure and variable. As the graph becomes more and more abrupt, be it going up or down, the significance is that the market becomes trendy, or stable. Fractal Chaos Bands Indicator is used similarly to other bands-indicator (Bollinger bands for instance), offering trading opportunities when price moves above or under the fractal lines.
High/Low Bands
High Low Bands consist of triangular moving averages calculated from the underling price, shifted up and down by a fixed percentage, and include a median value. When prices rise above the upper band or fall below the lower band, a change in direction may occur when the price penetrates the band after a small reversal from the opposite direction.
Moving Average Envelope
Moving Average Envelopes consist of moving averages calculated from the underling price, shifted up and down by a fixed percentage. Moving Average Envelopes (or trading bands) can be imposed over an actual price or another indicator. When prices rise above the upper band or fall below the lower band, a change in direction may occur when the price penetrates the band after a small reversal from the opposite direction.
Swing Index
The Swing Index (Wilder) is a popular indicator that shows comparative price strength within a single security by comparing the current open, high, low and close prices with previous prices. The Swing Index is a component of the Accumulative Swing Index.
Accumulative Swing Index
The Accumulative Swing Index (Wilder) is a cumulative total of the Swing Index. The Accumulative Swing Index may be analyzed using technical indicators, line studies, and chart patterns, as an alternative view of price action.
Comparative RSI
The Comparative Relative Strength index divides one price field by another price field. The base security is outperforming the other security when the Comparative RSI is trending upwards.
Mass Index
The Mass Index identifies price changes by indexing the narrowing and widening change between high and low prices. According to the inventor of the Mass Index, reversals may occur when a 25-period Mass Index rises above 27 or falls below 26.5.
Money Flow Index
The Money Flow Index measures money flow of a security, using volume and price for calculations. Market bottom below 20 and top above 80. Divergence of price and Money Flow Index are also used.
Negative Volume Index
The Negative Volume Index shows focus on periods when volume decreases from the previous period. The interpretation of the Negative Volume Index is that well-informed investors are buying when the index falls and uninformed investors are buying when the index rises.
On Balance Volume
The On Balance Volume indicator shows a relationship of price and volume as a momentum index. On Balance Volume index generally precedes actual price movements. The premise is that well-informed investors are buying when the index rises and uninformed investors are buying when the index falls.
Positive Volume Index
The Positive Volume Index shows focus on periods when volume increases from the previous period. The interpretation of the Positive Volume Index is that many investors are buying when the index rises, and selling when the index falls.
Relative Strength Index
The RSI (Wilder) is a popular indicator that shows comparative price strength within a single security. 9, 14 and 25 period RSI calculations are most popular. The most widely used method for interpreting the RSI is price/RSI divergence, support/resistance levels and RSI chart formations.
Trade Volume Index
The Trade Volume index shows whether a security is being accumulated or distribute (similar to the Accumulation/Distribution index). When the indicator is rising, the security is said to be accumulating. Conversely, when the indicator is falling, the security is said to being distributing. Prices may reverse when the indicator converges with price.
Stochastic Oscillator
The Stochastic Oscillator is a popular indicator that shows where a security’s price has closed in proportion to its closing price range over a specified period of time. The Stochastic Oscillator has two components: %K and %D. %K is most often displayed as a solid line and %D is often shown as a dotted line. The most widely used method for interpreting the Stochastic Oscillator is to buy when either component rises above 80 or sell when either component falls below 20. Another way to interpret the Stochastic Oscillator is to buy when %K rises above %D, and conversely, sell when %K falls below %D.
Stochastic Momentum Index
Commonly abbreviated to SMI, Stochastic Momentum Index is advancement in the Stochastic Oscillator. Stochastic Oscillator is primarily used to calculate the distance between the Current Close and Recent High/Low Range for n-period. Stochastic Momentum Index shows the distance of Current Close relative to the center of High/Low Range. SMI is reasonably less unpredictable than Stochastic Oscillator over a single period. SMI normally ranges in between +100 and -100. Stochastic Momentum Oscillator is used in conjunction with the TusharChande Momentum Oscillator.
Fractal Chaos Oscillator
When looking at price movement charts, if the time scale is not given, sometimes it’s very hard to determine whether the bars in the chart are referring to hours, days or months. The chart always looks exactly the same regardless of its time resolution, with the only difference being the size. To examine these patterns the Fractal Chaos Oscillator can be used to determine what is happening in the current level of resolution. Fractal Chaos Oscillator is a great indicator to use in intra-day trading.
Prime Number Oscillator
This indicator finds the nearest prime number from either the top or bottom of the series, and plots the difference between that prime number and the series itself. This indicator can be used to spot market turning points. When the oscillator remains at the same high point for two consecutive periods in the positive range, consider selling. When the oscillator remains at a low point for two consecutive periods in the negative range, consider buying.
Prime Number Bands
This indicator finds the nearest prime number for the high and low, and plots the two series as bands. This indicator can be used to spot market-trading ranges.
Historical Volatility
“Volatility” is an important term used in the stock markets and by many market professionals. Many investors use this term to manage their risk. “Volatility”, in simpler terms, means the fluctuation in a stock’s or any other underlying price, over a specific period of time. Volatility is divided in to two categories. The first one is “Historical volatility” and the other one is “Implied volatility”. “Historical volatility” is defined as the historical fluctuation in a particular underlying price, whereas “Implied volatility” is the estimation of volatility in an asset’s price. Generally, “Implied volatility” finds extensive use in “Options”.
Understanding “Historical volatility” is important for many investors as well as traders. For investors, this term is important, because it helps in estimating or calculating their risk. Traders, generally use “Historical volatility” to know how volatile a stock or an index will be in the future.
MACD Histogram
MACD Histogram measures the distance between MACD and its signal line (the 9-day EMA of MACD). Like MACD, the MACD-Histogram is also an oscillator that fluctuates above and below the zero line. It anticipates signal line crossovers in MACD. Because MACD uses moving averages and moving averages lag price, signal line crossovers can come late and affect the reward-to-risk ratio of a trade. Bullish or bearish divergences in the MACD-Histogram can alert chartists to an imminent signal line crossover in MACD.
Elder Ray Bull Power
Elder Ray Bull Power uses a 13-day exponential moving average (EMA) to indicate the consensus market value.
Elder Ray Bear Power
Bear Power is derived by subtracting the 13-day EMA from the day’s low. Where a currency downtrend is sustained to the point that minimum prices move below the EMA the Bear Power histogram will be less than zero. As price minimums accelerate to lower levels (below the EMA) during the falling trend histogram bars will increase in height below the zero line showing increased selling strength during the period.
Elder Force Index
Elder's Force Index (EFI) measures the power behind a price movement using price and volume. The indicator can also be used to identify potential reversals and price corrections. The EFI is an oscillator that fluctuates between positive and negative values, above and below a Zero line.
Elder thermometer
The Market Thermometer translates market activity into a "hot" and "cold" histogram for better visualization.
Ehler Fisher Transform
It was designed to identify major price reversals with its raANTd response time and sharp, clear turning points. The assumption is that prices do not have a Gaussian probability density function (bell-shaped curve movement), but by normalizing price and applying the Fisher Transform you could create a nearly Gaussian curve.
Keltner Channel
The Keltner Channel is a moving average band indicator who’s upper and lower bands adapt to changes in volatility by using the average true range. The Keltner Channel is used to signal price breakouts, show trend, and give overbought and oversold readings.
Market Facilitation Index
Market Facilitation Index Technical Indicator (MFI) is the indicator which shows the change of price for one tick. Absolute values of the indicator do not mean anything as they are, only indicator changes have sense.
Schaff Trend Cycle
The Schaff Trend Cycle Indicator is the product of combining Slow Stochastics and the Moving Average Convergence/Divergence (MACD). The MACD has a reputation to be a trend indicator, yet it has an equal reputation to be lagging due to its slow responsive signal line. The improved signal line gives the STC its relevance as an early warning sign to detect currency trends.
QStick
A technical indicator developed by Tushar Chande to numerically identify trends in candlestick charting. It is calculated by taking an 'n' period moving average of the difference between the open and closing prices. If Qstick value is greater than zero means that the majority of the last 'n' days have been up, indicating that buying pressure has been increasing.
STARC
STARC bands (Stoller Average Range Channels) are three bands forming a channel around simple moving average.
The indicator is similar to Bollinger Bands; STARC bands are narrowing on the flat markets and widening on the volatile markets. However, STARC bands do not measure the highness and lowness of the price and do not take into account standard deviation as Bollinger Bands. It is calculated by means of Average True Range (ATR) providing more detailed information on market volatility. Using STARC bands period 10 is an optimum parameter for ATR.
This indicator has two functions. First, it is used as a signal which recommends opening buy or sell deals when the price crosses the boarders of STARC bands. In this case one should wait till the price consolidates above or under the STARC bands and stop loss should be placed after the median line.
Second, STARC indicator can be used as an indicator whether the price is oversold or overbought. In order to do it index K should be moved from 3 to 1.33. In this case test of the price of STARC bands means the price has reached extreme values; the probability of price swing is very high. This signal should be accompanied by signals of oscillators pointing out oversold/overbought areas (for example, RSI indicator).
Center of Gravity
The Center of Gravity is an oscillator developed by John Ehler and presented in Stocks & Commodities magazine (05.2002). This oscillator produces almost zero lag indicating the ANTvot points with the precise accuracy. The indicator was the result of studies of adaptive filters.
Coppock Curve
The Coppock curve is a long-term price momentum indicator used primarily to recognize major bottoms in the stock market. Most technical market analysts consider the Coppock curve to be an excellent tool for discriminating between bear market rallies and true bottoms in the stock market. The indicator was designed for use on a monthly time scale and is calculated as a 10-month weighted moving average of the sum of the 14-month rate of change and the 11-month rate of change for the index.
Chande Forecast Oscillator
The oscillator is above the zero point if the forecast price is higher than the current price. On the contrary, if it is below it turns out to be less than zero. When the forecast price and the current price are equal, the oscillator makes a zero. Current prices that are constantly over the forecast price suggest higher prices ahead and prices that are constantly under the forecast price suggest lower prices ahead.
Gopalakrishnan Range Index
The Gopalakrishnan Range Index (GAPO) by JayanthiGopalakrishnan quantifies the variability in a stock, based on the logarithm of the trading range over an N-day period (default 5 days).
Random Walk
The basis of Random Walk Indicator is a theory of the shortest path from one point to another.
In case the prices stay too far from the line traced for a period, then the movement efficiency is considered to be minimal. Highly random movement creates considerably fluctuating RWI.
The number of periods, recommended by effective RWI applying is from 2 to 7 for the short term, whether the long- term requires from 8 to 64 periods. It is done to show the short- term fluctuations and long term trends. RWI peaks in the short term indicate with the price highs, whether its bottom describes price decline.
Intraday Momentum Index
The IMI (intraday momentum index) is a ratio of the total magnitude of the up day candle bodies to the total magnitude of the down day candle bodies over the past x-days. An up day candle body is white and is the close minus the open for a particular day. A down day candle body is black and is the open minus the close for a particular day. So if you see a lot of consecutive long white candle bodies and only a few short black body candle bodies on a stock chart then the IMI will be high (perhaps near 100%). The 'imi' indicator is used in indicator formula construction to narrow the stock pre-screener results to include only those stocks that have an imi restricted to the parameters set for the imi indicator.
Kinger Volume Oscillator
A technical indicator developed by Stephen Klinger that is used to determine long-term trends of money flow while remaining sensitive enough to short-term fluctuations to enable a trader to predict short-term reversals. This indicator compares the volume flowing in and out of a security to price movement, and it is then turned into an oscillator.
Pretty Good Oscillator
The Pretty Good Oscillator measures the distance of the current close from its N-day simple moving average, expressed in terms of an average true range over a similar period.
RAVI (Range Action Verification Index)
RAVI indicator, developed by Tushar Chande, can be used to identify whether the market is trending. It calculates the percentage difference between current prices and older prices. Current prices are represented by a Short SMA, and the longer time frame by a Long SMA. Tushar Chande recommends the following information lines for the indicator: plus-minus 0.3% or 0.1% (depending on the market).
Twiggs Money Flow
The main idea behind the TMF indicator is to evaluate volume (money flow) as bullish or as bearish based on a close price location. Chaikin Money Flow uses CLV (Close Location Value) to do it. Twigs Money Flow, on the other hand, uses TR (True Range). Another main difference is that CMF uses cumulative volume (sum of volumes over specified period) and the TMF applies Moving average to the volume.


[bookmark: __RefHeading___Toc444183496]Menu
The Main menu has all the controls to access options in ANT.

The Main menu consists of several sub- menus are:
· File
· Orders
· Positions
· Funds
· Chart
· Chart Tools
· View
· Alerts
· Artificial Intelligence
· Help


[bookmark: __RefHeading___Toc444183497]File menu
[image: ]
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Load Workspace
Load Workspace loads a workspace into ANT from Workspace folder saved in Alice Blue/ANT folder by default, if Workspace folder is not saved or created, ANT will create a new folder named Workspace. Workspace consists of Symbols added in market watch and charts. By default it will load the default workspace given with the application while starting ANT.


[bookmark: __RefHeading___Toc444183499]Save Workspace
Save Workspace allow the user to save their symbol list and charts to Workspace folder saved in Alice Blue/ANT folder by default, if Workspace folder is not saved or created, ANT will create a new folder named Workspace. User could save the workspace and save it on the disk. The user could load workspace to use the saved workspace.
[bookmark: __RefHeading___Toc444183500][bookmark: __RefHeading___Toc444183501]Load Chart from Disk
Load Chart from Disk helps user to load the saved chart back into ANT from Charts folder saved in Alice Blue/ANT folder by default, if Charts folder is not saved or created, ANT will create a new folder named Charts. The user can do technical analysis and other studies on the chart. The saved charts loaded from disk will be live.


[bookmark: __RefHeading___Toc444183502]Find Symbol
Find Symbol helps users to find a symbol from list of trading symbols.



[bookmark: __RefHeading___Toc444183503]Change Password
Change Password helps user to change his/her Login password and Transaction password.



[bookmark: __RefHeading___Toc444183504]Lock ANT
Lock ANT helps user to lock his/her current session in ANT, so nobody can touch his/her workspace. User can unlock it by entering the account password and click Continue. Three wrong attempts of entering password will log out ANT. User can also exit ANT after clicking on Exit button.



[bookmark: __RefHeading___Toc444183505]Exit
It exit's ANT and logs the user out.


[bookmark: __RefHeading___Toc444183506]Orders
From this menu, user can access to various types of Orders
· Normal Buy Order (F1 or Alt+F1)
· Normal Sell Order (F2 or Alt+F2)
· Cover Order Buy (Shift+F1)
· Cover Order Sell (Shift+F2)
· Bracket Order Buy (Shift+F3)
· Bracket Order Sell (Shift+F4)
· After Market Order Buy/Sell (Ctrl+F1/Ctrl+F2)
User can also view:
· OrderBook (F3)
· TradeBook (F8)


[bookmark: __RefHeading___Toc444183507]Buy/Sell Order
From this window you can place different types of Buy/Sell orders:
· Normal Orders
· Cover Orders(CO)
· Bracket Order(BO)
· After Market Orders(AMO)


[bookmark: __RefHeading___Toc444183508]Normal Order
Buy Normal Order
Shortcut: Alt + F1 or F1
User can place buy orders through this window. User can use shortcut keys or can select Buy Normal Order from Orders menu in main menu after selecting particular scrip from market watch which will invoke buy order window. User have to fill all required fields before click on submit button. User can use Tab button for faster navigation through this window and also use F1 and F2 to toggle between Normal Order Buy and Sell window.

Sell Normal Order
Shortcut:Alt + F2 or F2
User can place sell orders through this window. User can use shortcut keys or can select Sell Normal Order from Orders menu in Main menu after selecting particular scrip from market watch which will invoke sell order window. User have to fill all required fields before click on submit button. User can use Tab button for faster navigation through this window and also use F1 and F2 to toggle between Normal Order Buy and Sell window.

NOTE:
Differentiation between buy order window and sell order window call also be based on colour as always buy order window will be in blue and sell order window will be in red.
The user must enter the following details while placing a Buy or Sell order:
Exchange: The user must select the Instrument Name for which the order is to be placed.
Symbol: The user must select the desired Symbol for which the order is to be placed.
Type: The user must select the Option Type either CE or PE. This is Not Applicable for Cash Segment and commodities.
Strike Price: The user must select the Strike Price for which the order is to be placed. This is not applicable for Cash Segment and commodities.
ExANTry Date: The user must select the ExANTry Date. This is Not Applicable for Cash Segment.
Quantity: The user must enter the quantity that should be placed in the order.
Price: The user must enter the price at which the order is to be placed for the scrip.
Trigger Price: The user must enter the Trigger Price while placing Stop Loss orders, as the price at which the order is to get triggered.
Disc Quantity: The user can enter the disclosed quantity, that is, the quantity that is to be disclosed to the market.
Client Code: It is set default as unique for every user.


[bookmark: __RefHeading___Toc444183509]Cover Order
Cover order offers an order placement feature through which user can take a intraday position in equity/F&O/Commodities segment where in system will place the market order along with the stop loss market order which will get triggered at specified trigger price. This order will help user to limit the loss if any on the position.
Features:
· All orders placed through cover order product are market orders.
· Trigger price entered by the user for stop loss should be within trigger price range.
· RMS would validate this product type taking lesser margin (RMS would take flat percentage or cash co factor times the predefined trigger price % configured for individual scrips).
· If first leg is rejected the other is also rejected by the system.
· User can book the trade by converting the SL to market or the system will do it for user if he/she clicks on exit button.
· Cover orders are accepted for selected scrips as configured by the administrator.


Buy Cover Orders
Shortcut: Shift + F1
User can invoke Cover Order Buy from orders menu or can directly invoke from market watch after selecting particular scrip for which user want to place CO by using its short cut key.
For stop loss sell order:
When we are placing buy Cover Order, for the stop loss sell order trigger price should be within the range that is displayed in trigger price range box. Trigger price is calculated as LTP - Trigger percentage. User can use Tab button for faster navigation through this window and can use F1 and F2 to toggle between Cover Order Buy and Sell window.



Sell Cover Orders
Shortcut: Shift + F2
User can invoke sell cover order entry from orders menu. We can also invoke from market watch by using its short cut key.
For stop loss buy order:
When we are placing sell cover order, for the stop loss buy order trigger price should be within the range that is displayed in the trigger box price range. Trigger price range is calculated as LTP + trigger percentage.
User can use Tab button for faster navigation through this window and can use F1 and F2 to toggle between Cover Order Buy and Sell window.



[bookmark: __RefHeading___Toc444183510]Order Book for Cover Order
[image: http://tradelab.in/wp-content/uploads/2016/03/orderbookCO.png]


[bookmark: __RefHeading___Toc444183511]Cover Order Modification
The user places fresh cover order in to the system as first order is always market, it will be traded and as second leg is stop loss, it will be pending in the system. The user can modify only the price in the pending order window with limits that is mentioned in the trigger range box.

If the first order is not traded due to lack of market depth it will be sitting as limit order with price as Last traded price. The user can modify it to market again if he/she wants to.


[bookmark: __RefHeading___Toc444183512]After Market Order (AMO)
AMO Buy
Shortcut: Ctrl + F1
You can place After Market Buy orders through this window. You can use shortcut keys or can select AMO Buy from Orders menu in Main menu after selecting particular scrip from market watch which will invoke AMO Buy order window. You have to fill all required fields before click on submit button.
You can use Tab button for faster navigation through this window.

ANT allows the end user to place AMO orders from the terminal which will be parked at the server level. Next trading day these will be sent to the exchange.
AMO Sell
Shortcut: Ctrl + F1
You can place After Market Sell orders through this window. You can use shortcut keys or can select AMO Sell from Orders menu in Main menu after selecting particular scrip from market watch which will invoke AMO Sell order window. You have to fill all required fields before click on submit button. You can use Tab button for faster navigation through this window.



[bookmark: __RefHeading___Toc444183513]Bracket Order
A type of order where user can enter a new position along with a target/exit and also stoploss order. As soon as the main order is executed the system will place two more orders (profit taking and stoploss).
When one of the two orders (profit taking or stoploss) gets executed, the other order will get cancelled automatically.
Trailing Stoploss
When you place a bracket order, you get an option to either place a fixed stoploss order, or also a trail your stoploss. It means that if the contracts/stock moves in your direction by a particular number of ticks, the stop loss will go up/down based on if you are long or short automatically.
Note:
· This is an Intra-day product, so all Bracket order (BO) positions will be squared off by 3:20 pm.
· Enabled across Equity, Futures & Options and Currency. Bracket order is not allowed for Commodities.
Bracket Order Buy
Shortcut: Shift + F3
A Buy order that is accompanied by a sell limit order above the buy order’s price and a sell stop order below the buy order’s price. These three component orders will all be set at a price determined by the investor at the time the order is entered. This type of order allows investors to lock in profits with an upside movement and prevent a downside loss, without having to constantly follow the position.
User can place Bracket Order Buy through this window. User can use shortcut keys or can select Bracket Order Buy from Orders menu in Main menu after selecting particular scrip from market watch which will invoke Bracket Order Buy window. User have to fill all required fields before click on submit button. User can use Tab button for faster navigation through this window and can use F3 and F4 to toggle between Bracket Order Buy and Sell window.

Bracket Order Sell
Shortcut: Shift + F4
A sell order on a short sale that is accompanied (or bracketed) by a buy stop order above the entry price of the sell order and a buy limit order below the entry price of the sell order. As the three component orders are based on set prices, this type of order protects the investor from the downside but also potentially locks in a gain without the investor constantly monitoring price.
User can place Bracket Order Sell through this window. User can use shortcut keys or can select Bracket Order Sell from Orders menu in Main menu after selecting particular scrip from market watch which will invoke Bracket Order Sell window. User have to fill all required fields before click on submit button. User can use Tab button for faster navigation through this window and can use F3 and F4 to toggle between Bracket Order Buy and Sell window.



[bookmark: __RefHeading___Toc444183514]Order Book
Shortcut: F3
Once an order is placed, the user would like to see the status of that order. The Order Book window opens with Market Watch by default, when you log in into ANT. A user can call the order book window by pressing F3 in the market watch or from MarketWatch toolbar. This will show the status of all the orders that were placed. If the user presses F3 it would show the status of all the orders that were placed across all the segments as well as across the entire exchanges. The Order Book window is very user-friendly as it allows the user to view and access the data in a very efficient way. User can also set the columns in the sequence user prefers them to appear in the order book window. One can also remove the unwanted columns from the window. All the fields/columns can also be filtered by right clicking on columns and select choose columns. This allows the user to search for the information that user is looking for.
The Order Book provides details of all the orders placed by the user. These include orders placed to the exchange, but not traded or partially traded (open orders), traded orders (completed), rejected orders and cancelled orders.
The user can also modify or cancel an Open Order from this window, by selecting the order from order book and clicking on Modify or Cancel, as the case may be. Other functions like writing the orders to excel and view order history.
User can use Shortcut keys to Modify, Cancel, Cancel All and Exit orders in Orderbook.
For modifying the pending order user can use Shift+M shortcut key to modify the order. For cancel the selected pending order user can use Shift+K shortcut key to cancel the order. For cancel all pending orders, user can use Shift+A shortcut key. To exit the CO and BO user can use Shift+E shortcut key to exit the pending CO and BO.
[image: http://tradelab.in/wp-content/uploads/2016/03/orderbook-1.png]


Order History
For viewing the Order History by double clicking on the order can also be performed easily by the user.



[bookmark: __RefHeading___Toc444183515]Trade Book
Shortcut: F8
The Trade Book window displays the executed orders for all the scrips. This window can be invoked by using shortcut key from the market watch or can be selected from Orders menu or from MarketWatch toolbar. It will display the trade details as shown in the below figure.
You can write trade book to excel for his further reference and also can select desired columns from right clicking on column head and selecting on choose columns.
The summary displays the Total Buy Quantity, Total Buy Value, Total Sell Value, Sell Quantity and the Net Amount. Pressing F8 will display all the trades across all the scrips (All Segments All Exchanges).
[image: http://tradelab.in/wp-content/uploads/2016/03/tradebooknew.png]


[bookmark: __RefHeading___Toc444183516]Positions
Using this menu, user can access the various types of positions:
· Admin Position (F11)
· Cash Position (Ctrl+Shift+V)
· Stock Holdings (Alt+F9)


[bookmark: __RefHeading___Toc444183517]Admin Positions
Shortcut: F11
This window can be invoked using shortcut key or can be selected from Positions menu or from MarketWatch toolbar. The user can view the consolidated positions in the Net Positions Window. These positions can be further filtered according to the exchange/segment, according to the product tag and Opt/Fut calls or according to the Daywise/Netwise positions of the scrips for which the trade was made.
This window also provides some vital information like the Net Position, Buy Quantity, Sell Quantity, Buy Amount, Sell Amount, MTM profit/loss, etc.
If the user desires to square-off all his pending positions or a part of the open positions then he can do that by just selecting the scrip(s) and then entering the percentage of quantity or the exact quantity that user wants the system to be squared-off.
[image: http://tradelab.in/wp-content/uploads/2016/03/adminpos.png]
Convert Position
Convert Position button given in admin positions window will allow user to convert position from one product type to another product type.
It will consider all checks before converting position to other product type. For example is a position is initiated in MIS Product type and later user want to convert the same to NRML it will check if enough money is there or not to convert the selected position and then convert its product type.



[bookmark: __RefHeading___Toc444183518]Accounts (Cash Position)
Shortcut: Ctrl + Shift + V
This window can be invoked using shortcut key or can be selected from Positions menu or from MarketWatch Toolbar. Accounts window allows the user to view the limits for clients. The user will have to select the category for which the limit is to be viewed. All limits set for the selected client will appear in this window. How much cash is used, how much margin is blocked everything can be known from this window.
[image: http://tradelab.in/wp-content/uploads/2016/03/cash-positionnew.png]


[bookmark: __RefHeading___Toc444183519]DEMAT Holdings (Stock Holdings)
Shortcut: Alt + F9
In this window user can see his equity holdings which are in his DEMAT account. He/she can also see his/her T1 holdings. The valuation based on LTP for each exchange is showed on top of the window. You can open this window from Position menu or using shortcut Key or from MarketWatch Toolbar.
User can square off his positions from this window also. User can place both limit orders and market orders by selecting the desired position he want to close from his holdings. The user is provided to select columns based on his preference.
[image: http://tradelab.in/wp-content/uploads/2016/03/demat.png]


[bookmark: __RefHeading___Toc444183520]Funds Transfer
Pay In
Clicking on Pay In will open the payment gateway to transfer the fund from your bank account to your trading account with www.Alice Blue.com. Using this you can transfer the funds in any of the segment i.e. Equity, Commodities or Derivatives.
Pay Out
Clicking on Pay Out will open your Alice Blue backoffice page https://q.Alice Blue.com/.
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[bookmark: __RefHeading___Toc444183522]Save
· Save Chart on Disk
Save Chart saves the chart file on the Disk.
· Save Chart as Image
Save Chart as image saves the charts as snapshot.
· Save Chart as Template
Chart Template could be saved for later applying on charts to do similar technical study on all the charts.


[bookmark: __RefHeading___Toc444183523]Zoom In
To Zoom-in the selected chart.


[bookmark: __RefHeading___Toc444183524]Zoom Out
To Zoom-out the selected chart.


[bookmark: __RefHeading___Toc444183525]Scroll Left
To navigate through the chart, scroll left.


[bookmark: __RefHeading___Toc444183526]Scroll Right
To navigate through the chart, scroll right.


[bookmark: __RefHeading___Toc444183527]Apply Chart Template
User can apply his/her favorite indicators and colors at once.


[bookmark: __RefHeading___Toc444183528]Remove All Drawings
User can remove all the drawing objects in one click from the selected chart.


[bookmark: __RefHeading___Toc444183529]Chart Colors
Chart Color allows you to choose color for:
· Fore Color
· Back Color
· Grid Color
· Gradient Top Color
· Gradient bottom Color


[bookmark: __RefHeading___Toc444183530]Export Chart to Excel
All values on a chart may be exported to Excel. Simply click a chart to select it then click the Export Chart to Excel in Chart menu.


[bookmark: __RefHeading___Toc444183531]Chart Tools
The chart tools available in ANT are:


[bookmark: __RefHeading___Toc444183532]Trendline
A line that is drawn over ANTvot highs or under ANTvot lows to show the prevailing direction of price. Trendlines are a visual representation of support and resistance in any time frame. Trendlines are used to show direction and speed of price. Trendlines also describe patterns during periods of price contraction.
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Speed resistance lines (SRL) are especially useful when looking at issues that are inside of strong trends A chartist uses the SRL to determine support and resistance and can be used by those interested in both short and intermediate phases as well as long-term outlooks. Simply put, the SRL measures the line of an uptrend or a downtrend.


[bookmark: __RefHeading___Toc444183534]Gann Fan
A Gann fan consists of a series of diagonal lines called Gann angles, of which there are nine. These angles are superimposed over a price chart to show a security's support and resistance levels. The resulting image is supposed to help technical analysts predict price changes.
Gann fan relies heavily on subjective choices made by individual traders; the chart may be limited in its usefulness and accuracy. The three premises Gann based his theory on were: i) price, time and range are the only factors, ii) cyclical markets, and iii) geometric market design.
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A charting technique consisting of three curved lines that are drawn for the purpose of anticipating key support and resistance levels, and areas of ranging. Fibonacci arcs are created by first drawing an invisible trendline between two points (usually the high and low in a given period), and then by drawing three curves that intersect this trendline at the key Fibonacci levels of 38.2%, 50% and 61.8%. Transaction decisions are made when the price of the asset crosses through these key levels.


[bookmark: __RefHeading___Toc444183536]Fibonacci Retracement
A term used in technical analysis that refers to areas of support (price stops going lower) or resistance (price stops going higher). The Fibonacci retracement is the potential retracement of a financial asset's original move in price. Fibonacci retracements use horizontal lines to indicate areas of support or resistance at the key Fibonacci levels before it continues in the original direction. These levels are created by drawing a trendline between two extreme points and then dividing the vertical distance by the key Fibonacci ratios of 23.6%, 38.2%, 50%, 61.8% and 100%. Fibonacci retracement is a very popular tool used by many technical traders to help identify strategic places for transactions to be placed, target prices or stop losses. 
After a significant price movement up or down, the new support and resistance levels are often at or near these lines.
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A charting technique consists of three diagonal lines that use Fibonacci ratios to help identify key levels of support and resistance. Fibonacci fans are created by first drawing a trendline through two points (usually the high and low in a given period), and then by dividing the vertical distance between the two points by the key Fibonacci ratios of 38.2%, 50% and 61.8%. The result of these divisions, each represent a point within the vertical distance. The three 'fan' lines are then created by drawing a line from the leftmost point to each of the three representing a Fibonacci ratio.


[bookmark: __RefHeading___Toc444183538]Fibonacci Time Zones
An indicator used by technical traders to identify periods in which the price of an asset will experience a significant amount of movement. This charting technique consists of a series of vertical lines that correspond to the sequence of numbers known as Fibonacci numbers (1, 2, 3, 5, 8, 13, 21, 34, etc.). Once a trader chooses a starting position (most commonly following a major move) on the chart, a vertical line is placed on every subsequent day that corresponds to the position in the Fibonacci number sequence. 
Fibonacci numbers are a sequence of numbers where each successive number is the sum of the two previous numbers. For reasons unknown, these numbers play an important role in determining relative areas where the prices of financial assets experience large price moves or change direction. The four popular Fibonacci studies are arcs, fans, retracements and time zones.


[bookmark: __RefHeading___Toc444183539]Tirone Levels
A series of three sequentially higher horizontal lines used to identify possible areas of support and resistance for the price of an asset. The position of the center line is plotted by calculating the difference between the highest high and the lowest low for the asset price over a period of time and dividing it by 2. The top and bottom line are drawn 1/3 and 2/3 of the difference, respectively, between the same high and low that are used to calculate the center line.
The use of Tirone levels is similar to that of Fibonacci retracement, and both are interpreted in the same way. They both determine the position of the lines by using a percentage of the difference between a high and a low. Both Tirone levels and Fibonacci retracement use 50% as one of the possible support/resistance levels.


[bookmark: __RefHeading___Toc444183540]Quadrant lines
Quadrant Lines are a series of horizontal lines splitting the highest and lowest values of a security's prices into four equal sections. They provide for day trading methods yet another set of useless lines that probably do no more than clutter the screen. To calculate them, find the highest high and the lowest low during the time period under question. The top line is drawn horizontally thru the highest price during the time period and the bottom line is drawn horizontally thru the lowest price during the time period. The remaining three lines are then drawn by dividing the two outer lines into four equal sections. The center line (a.k.a. the "mean") is usually shown too.


[bookmark: __RefHeading___Toc444183541]Raff Regression
The Raff Regression channel is a great confirmation tool though, both for seeing active trends and helANTng to spot trend reversals. When user connects the regression line to the low and high point of a trend, the regression line will swivel all over the place as it calculates the ideal trajectory. The end result is a line that runs through most of the price action.


[bookmark: __RefHeading___Toc444183542]Error Channels
Standard Error Channels are calculated by plotting two parallel lines above and below an x-period linear regression trendline. The lines are plotted a specified number of standard errors away from the linear regression trendline.


[bookmark: __RefHeading___Toc444183543]Rectangle
A pattern formed on a chart where the price of a security is trading within a bounded range in which the levels of resistance and support are parallel to each other, resembling the shape of a rectangle. This pattern signals that the price movement, which has stalled during the pattern, will trend in the direction of the price breakout of the bounded range.
The bounded range, or rectangle, is a period of consolidation in which market participants are generally indecisive. The formation of this pattern will see the price of the security test the levels of support and resistance several times before a breakout. Once the security breaks out of the range, in either direction, it is considered to be trending in the direction of the breakout.


[bookmark: __RefHeading___Toc444183544]Ellipse
Just Select Ellipse from Chart Tools and drag across the chart to easily draw an ellipse of any size and at any angle. When finished user can edit the location, size, angle, etc to fine tune it to market data. User can drag it to other areas of ANT chart to identify the dominant price-time limits of the market data. Future movements are contained within the limits of the perimeter of these ellipses.


[bookmark: __RefHeading___Toc444183545]Free Hand Drawing


[bookmark: __RefHeading___Toc444183546]View Menu
View Menu has User settings and other User Interface customizations.



[bookmark: __RefHeading___Toc444183547]User Settings
Shortcut: Ctrl + P
User settings have settings which can be customized by user according to their choice. User setting form has General, Sound Alerts, MarketWatch, Market Indices and Order Window.
General Settings
· Session ExANTry time in minutes can be specified here
· Reconcile button will reconcile all Order/Trades/Baskets.
· Prompt on Alerts/EA/ANTBridge semi- automated will pop out alerts messages when user apply Scripted alerts/EA on chart and use ANT bridge.
· Admin Position Settings (NFO & BFO) can be selected here either in Qty or in Lots. It will show Net Buy Qty in Admin position either in Qty or in Lots.
· User can select Compact SnapQuote from here.
· Default Settings button will set General settings page to default.

Sound Alerts
· Sound Alerts for Alerts could be Enabled/Disabled.
· Sound Alerts for Expert Advisers could be Enabled/Disabled.
· Sound Alerts for Order related events could be Enabled/Disabled.
· Default Settings button will set Sound Alerts settings page to default.

MarketWatch Settings
· Change the Font, Font size and Font style.
· Change the Marketwatch tick color.
· Select the Save charts in Workspace/Exit option.
· Select the Market Watch save confirmation on exit.
· Select the Intraday Chart time interval (minutes).
· Default Settings button will set Market Watch settings page to default.

Market Indices
· Show Market Indices Floating window.
· Add or remove indices from the Market indices list.
· Default Settings button will set Market Indices settings page to default.

Order Window
· Select the default Product type & Order Qty(in Lots) for F&O.
· Select the default Product type & Order Qty(in Qty)for CM.
· Select the default Order type while placing the order.
· ANTck the Order Qty either by default Order Qty (CM & F&O) or from SnapQuote Qty while opening Order window from SnapQuote.
· Order window focus will be selected between Order Qty and Order Price.
· Selecting Confirm before selecting order will ask confirmation every time while placing an order.
· Selecting Transaction Password required will ask to enter transaction password every time while placing an order.
· Default Settings button will set Order Window settings page to default.
[image: http://tradelab.in/wp-content/uploads/2016/02/order-tab-US.png]
ANT Bridge Settings
(This setting will be enabled only when user will be subscribed to ANT Bridge)
1. Mock
In this mode, only logging (C:\Alice Blue\ANT\ANTBridge.log) for order placing from Amibroker etc. would be done. There won’t be any generated alerts.
2. Semi Auto(Orders)
In this mode, both logging and generated alerts only for order placing from Amibroker etc would be done.
3. 2Way SemiAuto
In this mode, all requests and responses would be logged. (For more details, please refer ANT bridge document)
4. Start ANT Server Automatically
To run ANT bridge server on ANT startup.
5. Default Settings button will set ANT Bridge Window settings page to default.
By default, SemiAuto mode will be selected.

Chart Settings
User can save these features on charts for future references.
1. Chart Colors
· UpTick
To change the UpTick candle color on chart.
· DownTick
To change the DownTick candle color on chart.
· Chart Tool
To change the chart tool color on chart.
2. Chart Styles
· Use X Grid
Show X Grid in charts.
· Use Y Grid
Show Y Grid in charts.
· Show Panel Separators
Show Separator between panels in chart Window. If you have checked Show separate panel option in View menu then it’ll show a separate panel on chart for indicators else it’ll hide the separate panel.
· Three D Style
Enable 3D style for charts. If you have checked Three D style option in View menu then it’ll show charts in 3D view.
· Darvas Boxes
Enable Darvas Box on charts.
· Volume Panel
Show Volume Panel on charts.
3. Chart Tools
· Cross Hair
· Data Box
· Day Separator
· ANTvot Lines
· Quick Order Panel
To place Quick Limit Order through charts. It can also be used to view SnapQuote.
· Confirm Quick Order
User can disable the confirmation message while placing the Quick Limit order using Quick Order Panel.
*Note: Do not uncheck, order may be executed at single click inadvertently.
4. Default Templates
In this feature of ANT, three Templates are provided by default, user can select any one of them to use it as default Template on charts.
User can make his own template and set it as default template on charts.
*Note: Default Template should be used on chart of data till 60 days (1Min).
6. Thickness
User can change the thickness of horizontal and vertical line up to 5 points on chart.
· Horizontal Line
· Vertical Line
7. Chart Toolbar
User can select any type of chart toolbar
· Floating Toolbar
[image: http://tradelab.in/wp-content/uploads/2016/02/floatingtoolbar.png]
Floating Toolbar View 1

Floating Toolbar View 2
· Fixed Toolbar

8. Default Settings button will set Chart Settings page to default.

Advanced Chart Toolbar
1. Search Scrip
· User can open new scrip’s chart by using this feature on an already opened chart.

2. Time Frame
· User can change timeframe on an already opened chart according to the periodicity.
· For eg: For min chart, user can change only to min, hourly to hourly, for day: user can’t switch to any timeframe. (limitation as of now)
3. Study
· User can add Technical Indicators using study dropdown. User can also search the indicators by tyANTng the indicator name in the study search box provided.
4. Chart Type
· User can change the chart type using this particular dropdown.
5. Chart Tools
· Trendline
· Ellipse
· Speedlines
· Gann Fan
· Fibonacci Arcs
· Fibonacci Retracements
· Fibonacci Fan
· Fibonacci Time Zones
· Tirone Levels
· Quadrant Lines
· Raff Regression
· Error Channels
· Rectangle
· Freehand Drawing
6. Buy Symbol
7. Sell Symbol
8. Exit Symbol
9. Text Object
10. Zoom In/Zoom Out
11. Scroll Right/Left
12. Apply Template
13. Remove Drawings


[bookmark: __RefHeading___Toc444183548]Pop Out Active Window
Using this Pop out Active window option in View menu, you can open separate window of any tab by selecting that particular active tab in ANT. You can open as many separate windows as you want using this option.
[image: http://tradelab.in/wp-content/uploads/2016/03/popout.png]


[bookmark: __RefHeading___Toc444183549]View News Reader
[image: http://tradelab.in/wp-content/uploads/2016/03/newsreader-1.png]
News Reader helps User get news from a large no of RSS feed sources simultaneously and filter according to keywords. You could add your favorite sources on clicking and do other setting changes using the settings button. Refresh button helps you to refresh the News from the source. You could also filter the news for Keywords.
Once the news gets populated you could select the NEWS using mouse which shows a summary of the news at the bottom window. On double-click the news reader goes to the link of the news.
[image: http://tradelab.in/wp-content/uploads/2016/03/rsssettings-1.png]


[bookmark: __RefHeading___Toc444183550]View Market Index
Shortcut: Ctrl + M
Show or hides the floating window showing Market Indices. You can use the shortcut key to show or hide Market Index.


[bookmark: __RefHeading___Toc444183551]View Quick Order
Shortcut: Ctrl + Q
Shows or hides the Quick Order window in the charts. You can use the shortcut key to show or hide Quick Limit Order window. You can place a Limit order on Charts or can also open SnapQuote using Quick Limit Order window.


[bookmark: __RefHeading___Toc444183552]View Application style
ANT is equipped with various styling themes which could be chosen by user.
Application style allows you to choose following styles
· Blue
· Silver
· White
· Alice Blue Theme(Default theme)


[bookmark: __RefHeading___Toc444183553]Alerts Menu
This menu consists of following sub-menus:
· Create Scripted Alert
· Scanner
· Backtest
· Generated Alerts


[bookmark: __RefHeading___Toc444183554]Create Scripted Alerts
Alerts can be accessed from Create Scripted alerts from Alerts Menu item in Main Menu or by Click the Scripted Alerts Icon in Side menu on the left.
User can provide program instructions to display trade alerts by clicking the Alert button on the side toolbar or can be loaded from the Data, Create Scripted Alerts menu.
User can provide instructions that tell the application to play a sound or pop-up when a specific series of events occur, as specified by four program scripts. A script is a set of instructions written in the TradeScript. For example, a script might consist of just one line such as “LAST > 350 AND HIGH > 351.25”, or it may consist of many lines of instructions.
A separate programming manual is provided for the TradeScript, which can be viewed by clicking the Script Guide button on any Alert window or can be selected from Help menu in Main menu.
User can load an existing alert by selecting a Profile name from the drop down menu (if any exist). To create a new alert, type a Profile name, data selection criteria, enter at least a buy and sell script (exit-short and exit-long scripts are optional). Finally, click the Enable Alerts button to turn the alert on. When the underlying data is matched with one of user’s alert scripts, an alert will broadcast to users running Desktop.
On selecting Go Live button Pop up alerts will come showing the details of the alerts generated on clicking the close button order form will come to place the orders accordingly depending it is buy or sell signals.
User can select the Order type either Normal or Cover Order in Order section given below and can also select the Product type and Quantity in order details section.
User can add Symbol on which you want to generate Buy/Sell alerts by clicking on Select Symbol button:

[image: http://tradelab.in/wp-content/uploads/2016/03/alerts.png]
The alerts pop-up on cancelling will popup the order form with details mentioned in the alerts window like quantity, order type etc. If left for more than 5 sec it will be removed.
To Disable the Alert’s popup user could click stop live button. However user could still receive the Alert’s message in alert window and in MarketWatch’s message window. To disable an alert at any time, simply click the Disable Alerts button.


[bookmark: __RefHeading___Toc444183555]Scanner
The Stock Scanner feature can be accessed from the Alerts menu in Main menu.
A stock scanner is a tool that allows user to search several symbols simultaneously for certain criteria.
The stock scanner that is built into ANT allows user to accomplish this by means of the TradeScript.
To create a new scanner, select Scanner from Alert menu in the Main menu. Next, click on New Scanner button. A dialog will display:

To create a new scanner, select Stock scanner from Alert menu in the main menu. Next, click on New Scanner button. A dialog will display:

Here user could give name to the scanner and simply type trade script into the script text box then choose the appropriate bar interval, periodicity and no. of days values. Always use candles less than 20000 for optimum performance. Next, click the Add Symbol button to add symbols on which user want to run the scanners.



Here user could search the Symbols and add to list of symbols on which he/she want to run the scanner. Click OK button to select the list of symbols. Now select OK button for saving the scanner.
User could now see the newly defined scanner in scanner list. Just select the scanner and press Load button to start the scanner. User could also edit or using Edit and Delete buttons.
The scanner gets loaded in the list of scanners created by user. User can select the scanner and click Load button to start a scanner. Scanner allows for one symbol per new line.
The scanner will take several moments to load the historic data into memory; therefore this start-up task should be run prior to the market opening.
The back test screen will run in real time after the historic data has been loaded into memory.
The Trade Time cell indicates when the last trade occurred. The Alert Time cell indicates when user’s script last generated a signal.
The Trade button allows user to place a trade, the Chart button allows user to open a chart, the Settings button allows user to customize the script for the selected symbol only. The stop button will give a message box ask you “StopANTng the scanner will require a complete re-priming of data if user wish to restart the scanner” and clicking on Yes will stop the scanner or clicking on No will continue with the scanner.
The scanner can be edited, by clicking Edit button and the script bars, bar intervals etc could be changed and saved. The scanners can be selected in list of scanners and deleted by clicking Delete button.


[bookmark: __RefHeading___Toc444183556]Back Testing
The Back Testing screen can be loaded from the Alerts menu in the Main Menu.
Back Testing is a method that traders use to test their trading strategies against historical market conditions. Knowing how much profit or loss a trading system generated in the past may help prevent or reduce the risk of loss in real trading.
[image: http://tradelab.in/wp-content/uploads/2016/03/backtest.png]
The Abacus Back Testing engine can calculate user’s trading system's performance using nearly two-dozen scientific profit, loss and risk measurements. Abacus allows user to specify individual instructions for buying, selling, holding, and exiting his/her simulated trades. To run a Back Test, simply enter and verify your buy, sell, and exit scripts then click the Back Test button. The Buy Script is a set of instructions for buying (going long) and the "Sell Script" is a set of instructions for selling (going short).
The scripts required on this screen are based on the Abacus programming language. Please refer to the Abacus programming guide for complete details. Click on Script guide will open Tradescript Help document for user to learn how to write Buy, Sell and Exit scripts.

User can add symbol by clicking on Select Symbol button which will open Select symbol window to select symbols from any of the exchanges to perform the Backtesting.

Back Test Results Overview
Some trading strategies work well on a wide range of securities but work poorly with some securities. Reasons may include poor market liquidity for a particular stock (low volume), high volatility and other factors. It is a good idea to test user’s own strategy across a wide range of securities. Just because it isn’t very profitable on one security doesn’t mean it won’t work well with another security.
The values on the back testing page represent a range of measurements based on profitability and risk of user’s trading system when tested with the symbol that user supplied at the top of the back test screen. The output on the back testing results list provides an overall ANTcture of how user’s strategy might perform if used as a live trading system.
Overview of Back Test Outputs
Total Number of Trades
Total number of trades including buy, sell, and exit trades.
Average Number of Trades per Month
Average number of trades per month, including buy sell, and exit trades.
Number of Profitable Trades
Total number of profitable trades since the beginning of the back test.
Number of Loosing Trades
Total number of un-profitable trades since the beginning of the back test.
Total Profit
Total profit since the beginning of the back test.
Total Loss
Total loss since the beginning of the back test.
Percent Profit
Percentage of profitable trades in since the beginning of the back test.
Largest Profit
Largest single-trade profit.
Largest Loss
Largest single-trade loss.
Maximum Drawdown
The maximum account drawdown, defined as the percent retrenchment from equity peak to equity valley. A drawdown is in effect from the time an equity retrenchment begins until a new equity high is reached.
Maximum Drawdown (Monte Carlo)
Same as Maximum Drawdown, except the test is repeated 5,000 times, with each test introducing a small random slippage. Preferred over regular drawdown.
Value Added Monthly Index (VAMI)
Reflects the growth of a hypothetical $1,000 in a given investment over time. The index is equal to $1,000 at inception. Subsequent month-end values are calculated by multiplying the previous month’s VAMI index by 1 plus the current month rate of return.
Where Vami 0=1000 and
Where R N=Return for period N
Vami N= (1 + R N) X Vami N-1
Compound Monthly ROR
The geometric mean is the monthly average return that assumes the same rate of return every period to arrive at the equivalent compound growth rate reflected in the actual return data.
Standard Deviation
Measure the degree of variation of returns around the mean (average) return. The higher the volatility of the investment returns, the higher the standard deviation will be.
Where R I=Return for period I
Where M R=Mean of return set R
Where N=Number of Periods
M R = (∑ R I) ÷ N
I=1
(∑ (R I - M R) 2 ÷ (N - 1)) ½
Annualized Standard Deviation
Standard Deviation X (12) ½
Downside Deviation (MAR = 10%)
Similar to the standard deviation above except the downside deviation considers only returns that fall below a defined Minimum Acceptable Return (MAR) rather than the arithmetic mean. For example, if the MAR were assumed to be 10%, the downside deviation would measure the variation of each period that falls below 10%. (The loss standard deviation, on the other hand, would take only losing periods, calculate an average return for the losing periods, and then measure the variation between each losing return and the losing return average).
Where R I=Return for period I
Where N=Number of Periods
Where R MAR=Period Minimum Acceptable Return
Where L I=R I - R MAR (IF R I - R MAR < 0 ) or 0 ( IF R I - R MAR ³ 0 )
((S (L I) 2) ¸ N) ½
I=1
Downside Deviation = ((S (L I ) 2 ) ¸ N ) ½
Where NL=Number of Periods where R I - M < 0
Sharpe Ratio
A measure developed by William Sharpe that is defined as the incremental average return of an investment over the risk free rate. Risk (denominator) is defined as the standard deviation of the investment returns.
Where R I=Return for period I
Where M R=Mean of return set R
Where N=Number of Periods
Where SD=Period Standard Deviation
Where R RF=Period Risk Free Return
M R = (∑ R I) ÷ N
I=1
SD= (∑(R I - M R) 2 ÷ (N - 1)) ½
I=1
Sharpe Ratio= (M R - R RF) ÷ SD
Sortino Ratio (MAR = 5%)
A return/risk ratio developed by Frank Sortino. Return (numerator) is defined as the incremental compound average period return over a Minimum Acceptable Return (MAR). Risk (denominator) is defined as the Downside Deviation below a Minimum Acceptable Return (MAR).
Where R I=Return for period I
Where N=Number of Periods
Where R MAR=Period Minimum Acceptable Return
Where DD MAR=Downside Deviation
Where L I=R I - R MAR (IF R I - R MAR < 0) or 0 ( IF R I - R MAR ≥ 0 )
DD MAR= ((∑( L I ) 2 ) ÷ N ) ½
I=1
Sortino Ratio = (Compound Period Return - R MAR) ÷ DD MAR
Annualized Sortino ratio (MAR = 5%)
Annualized Sortino=Monthly Sortino X (12) ½
Calmar Ratio
A return/risk ratio. Return (numerator) is defined as the Compound Annualized Rate of Return over the last 3 years. Risk (denominator) is defined as the Maximum Drawdown over the last 3 years. If three years of data are not available, the available data is used.
Sterling Ratio (MAR = 5%)
A return / risk ratio. Return (numerator) is defined as the Compound Annualized Rate of Return over the last 3 years. Risk (denominator) is defined as the Average Yearly Maximum Drawdown over the last 3 years less an arbitrary 10%. To calculate this average yearly drawdown, the latest 3 years (36 months) is divided into 3 separate 12-month periods and the maximum drawdown is calculated for each. These 3 drawdowns are averaged to produce the Average Yearly Maximum Drawdown for the
3-year period.
Where D1 Calmar Ratio = Average Annual ROR /Worst drawdown = Maximum Drawdown for first 12 months
Where D2 = Maximum Drawdown for next 12 months
Where D3 = Maximum Drawdown for latest 12 months
Average Drawdown = (D1 + D2 + D3) / 3 Sterling Ratio = Compound Annualized ROR /ABS ((Average Drawdown -10% ))


[bookmark: __RefHeading___Toc444183557]Generated Alerts
The Generated Alerts window will show the Buy/Sell alerts created using the scripted alerts. Using this window user can buy or sell the particular stock on which alerts are generated. In this window, the information provided for the any stock are Time at which alert is generated, Source Component, Strategy using which alerts are generated, Exchange, Trading Symbol, Order Type, etc. User can also add more columns to this window by right clicking on top of the data grid and selecting the Choose column option.
[image: http://tradelab.in/wp-content/uploads/2016/03/generatedalerts.png]


[bookmark: __RefHeading___Toc444183558]Artificial Intelligence


[bookmark: __RefHeading___Toc444183559]Expert Advisors
Expert Advisors can be attached to charts so that a popup alert will display anytime a buy or sell strategy generates a signal.
To create an Expert Advisor, open a chart and click the Expert Advisors, Create New Expert Advisor menu.

Simply type a name, description, message, a buy script and a sell script (using the TradeScript).
The message will be displayed in the popup window whenever your expert advisor generates a signal. You may enclose constants within brackets, separated by a ANTpe character. For example you may write text such as the following: "The SMA just crossed [over|under] the close, generating a [buy|sell] signal". The first value will be interpreted for long positions while the second value will be interpreted for short positions. You can also use HTML formatted text such as <b></b> for bold, <font color=red></font> for red text, etc. You can save your script by clicking on Save button and can also check the preview of your scripts by clicking on Preview button, an Alert popup message will appear showing the message you saved in the EA script at the bottom of the screen.


[bookmark: __RefHeading___Toc444183560]Apply Expert Advisor
Using this option in Artificial Intelligence, user can apply various EA on the charts to generate Buy or Sell signals. There are 35 public Expert Advisors are available in ANT. User can also use Expert Advisor made by the user himself.

User can also view the public expert advisor script:



[bookmark: __RefHeading___Toc444183561]Edit Expert Advisor
Using this option in Artificial Intelligence, user can also edit EA made by him.

After selecting the EA, click on Edit Selected EA and user will be able to edit EA.
Note: User will not be able to edit any of the public EAs.

User can also delete the EA made by him.


[bookmark: __RefHeading___Toc444183562]Consensus Reports
Consensus Reports are simply groups of Expert Advisors that are processed simultaneously and the results are aggregated into one ranking value.
User may access this feature by opening a chart then selecting Consensus Report in Artificial Intelligence menu.

Simply select one or more Expert Advisors then click the Apply button.

The Consensus Report will list the generated signals for each selected Expert Advisor, along with a ranking value represented inside a gauge.


[bookmark: __RefHeading___Toc444183563]Pattern Recognition
The Pattern Recognition feature of ANT allows user to search for patterns within the currently selected chart.
To use this feature, click the Chart, Pattern Recognition item from the main menu
A dialog will display. Select <launch pattern designer…> from the list.


Use the pencil icons to draw pattern then enter the appropriate settings in the text boxes below. Please refer to the Advanced Pattern Recognition documentation for a complete overview of these settings.
After clicking on the Save button, return to ANT and select Chart, Pattern Recognition again. The pattern created by user will be listed. Simply click on pattern to search for it within the currently selected chart.


[bookmark: __RefHeading___Toc444183564]Help Menu


[bookmark: __RefHeading___Toc444183565]Registration Details
User can see the registration details by clicking on Help menu and selecting Registration details.



[bookmark: __RefHeading___Toc444183566]Web Links
User can open the any of these given web links of NSE, BSE, MCX, SEBI, FMC and Corporate Actions by selecting from Web Links menu in Help menu.

· If you select NSE, you will be redirected to:
http://www.nseindia.com/
· If you select BSE, you will be redirected to:
http://www.bseindia.com/
· If you select MCX, you will be redirected to:
http://www.mcxindia.com/
· If you select SEBI, you will be redirected to:
http://www.sebi.gov.in/sebiweb/
· If you select FMC, you will be redirected to:
http://www.fmc.gov.in/
· If you select Corporate Actions, you will be redirected to:
http://www.bseindia.com/markets/Equity/EQReports/MarketWatch.aspx?expandable=2


[bookmark: __RefHeading___Toc444183567]Help Contents
User can view this Help document by selecting Help Contents in Help menu.


[bookmark: __RefHeading___Toc444183568]ANT Trading Q&A
User can select ANT trading Q&A in Help menu, you will be redirected to:
http://Alice Blue.com/z-connect/category/tradeAlice Blue/ANT-tradeAlice Blue .
On this link you can ask your queries regarding ANT and you can also get more information about ANT.


[bookmark: __RefHeading___Toc444183569]Trading Script Help
User can view Trade Script help document by selecting TradeScript Help in Help menu. Using this document you can write your own Trade script that will help you to generate scripted alerts, Backtest, EA and scanner.


[bookmark: __RefHeading___Toc444183570]Check for Updates
When new update of ANT will be available, ANT will show a popup for new updates. User can updates ANT using Check for Updates in Help menu.
Update Available
When user clicks on Check for Updates in Help menu, It’ll open a dialog like:

Update downloading
After clicking on Yes, It’ll start downloading the new update of ANT.

Patch applied



[bookmark: __RefHeading___Toc444183571]About ANT
User can see the version and release date of ANT here.



[bookmark: __RefHeading___Toc444183572]Keyboard Shortcuts
	Functionality
	Shortcut Keys

	1.Change Password
	Ctrl + Shift + F9

	2. Exit
	Alt + F4

	3. Buy Order
	F1 or Alt + F1

	4. Sell Order
	F2 or Alt + F2

	5. Cover Order Buy
	Shift + F1

	6. Cover Order Sell
	Shift + F2

	7. After Market Order Buy
	Ctrl + F1

	8. After Market Order Sell
	Ctrl + F2

	9. Bracket Order Buy
	Shift + F3

	10. Bracket Order Sell
	Shift + F4

	11. Order Book
	F3

	12. Modify Order
	Shift + M

	13.Cancel Order
	Shift + K

	14. Cancel All
	Shift + A

	15. Exit Order
	Shift + E

	16. Trade Book
	F8

	17. Admin Position
	F11

	18. Cash Position
	Ctrl + Shift + V

	19. Stock Holding
	Alt + F9

	20. User Settings
	Ctrl + P

	21. View Market Index
	Ctrl + M

	22. View Quick Order
	Ctrl + Q

	23. Scrip Property
	Shift + F7

	24. Snap Quote
	F6

	25. Chart settings
	Shift + C

	26. Add blank space in market watch
	Space Bar


	27. Chart Shortcuts
27. 1. Zoom Out /In
27.2. Scroll Left /Right
27.3 Navigate to 1st 100 bars
27.4 Navigate to last 100 bars
	---
Arrow Key Down/ Up
Arrow key Left/Right
Home
End


	28. Reconcile
	Ctrl + R
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